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Lista Domande

Argomento: applicazioni
Un file che codifica un documento contiene:

�  dipende dal tipo di documento
�  una sequenza di byte
�  testo non formattato

Quali fra i seguenti sono programmi applicativi:
�  Excel
�  HTTP
�  HTML
�  DreamWeaver

Quali fra i seguenti sono browser:
�  Microsoft Word
�  Internet Explorer
�  Netscape Navigator
�  Archie

Quale fra i seguenti e’ un programma per la creazione e la gestione di siti Web:
�  Internet Explorer
�  Windows
�  HTTP
�  Dreamweaver

L’applicazione Notepad nel sistema Windows permette di gestire:
�  documenti HTML
�  documenti di testo formattato
�  documenti di testo non formattato

Se utilizziamo Internet Explorer 5 per salvare una pagina contenente 2 frame, i documenti visualizzati nei 
due frame vengono salvati:

�  nella stessa cartella del frame set
�  in una sottocartella di quella usata per il frame set
�  viene salvato solo il frame set

Le immagini animate che si trovano in molte pagine Web sono in formato
�  GIF
�  JPEG
�  HTML

L’estensione .htm rappresenta:
�  .htm non e’ un’estensione valida
�  documenti HTML prodotti esclusivamente con Dreamweaver
�  documenti HTML (pero’ .html e’ preferibile)

L’estensione .txt rappresenta comunemente:
�  documenti di testo non formattato
�  documenti di testo formattato (ma non colorato)
�  documenti HTML

Excel e’ un:
�  gestore di fogli elettronici
�  programma applicativo che permette la memorizzazione di testi e numeri
�  programma applicativo che permette la condivisione di dati numerici su Internet



Lista Domande http://phd.cs.unibo.it/esweb/lista_domande2.php

2 of 17 11/12/03 17:34

Internet Expolorer e’:
�  un browser
�  un applicativo che permette la visualizzazione di documenti HTML
�  un programma per comporre documenti HTML

Outlook Express e’:
�  un programma applicativo
�  un cliente di posta elettronica
�  un browser

Dreamweaver e’:
�  un browser
�  un programma applicativo
�  un programma per comporre documenti HTML

HTTP e’:
�  un protocollo
�  un programma applicativo
�  un collegamento di rete

Quali fra i seguenti programmi applicativi è un programma di videoscrittura:
�  Notebook
�  Outlook
�  Wordpad
�  Excel

Quali fra i seguenti programmi applicativi sono programmi di browsing?
�  Netscape Communicator
�  Netscape Navigator
�  Internet Explorer
�  Excel

Quali fra i seguenti programmi applicativi servono specificatamente per la gestione della posta elettronica:
�  Access
�  Internet Explorer
�  Netscape Communicator
�  Eudora
�  Outlook

Qual e’ l’estensione tipica di un file scritto in WORD?
�  wrd
�  doc
�  wor
�  .ps

Qual e’ l’estensione tipica di un file scritto in EXCEL?
�  xls
�  cel
�  exc

Quale tipo di documenti permette di visualizzare il programma applicativo Acrobat Reader?
�  i documenti Postscript
�  i documenti con estensione PDF
�  i documenti in ASCII esteso

Quali fra i seguenti sono esempi di ipertesti:
�  la guida in linea di WORD
�  la Divina Commedia
�  una presentazione PowerPoint con collegamenti a file esterni
�  una animazione accompagnata da commento musicale
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Quali fra i seguenti programmi applicativi sono all’interno del pacchetto OFFICE di Microsoft:
�  Excel
�  WordPad
�  PowerPoint
�  Windows NT

Supponiamo di collegare all’interno di un documento WORD un oggetto usando la tecnica OLE. Se voglio 
che il collegamento sia sensibile alle variazioni dell’oggetto collegato devo adottare la modalita’:

�  Linked
�  Embedded
�  Connected

Supponiamo di collegare all’interno di un documento WORD un oggetto usando la tecnica OLE. Se voglio 
che il collegamento NON sia sensibile alle variazioni dell’oggetto collegato devo adottare la modalita’:

�  Embedded
�  Connected
�  Linked

Una tabella Word e’ una base di dati se:
�  e’ strutturata in righe e colonne
�  la prima riga contiene i titoli dei campi e le altre righe le descrizioni dei record
�  contiene del testo

Per realizzare una stampa unione con il programma di videoscrittura Microsoft Word bisogna definire un 
documento principale ed una origine dei dati. Il documento principale e’:

�  un documento solo testo
�  un documento WORD
�  una tabella WORD

Per realizzare una stampa unione con WORD bisogna definire un documento principale ed una origine dei 
dati. L’origine dati e’:

�  un documento WORD contenente una tabella
�  un documento EXCEL
�  una base di dati descritta in WORD

Cos’e’ un modello di WORD?
�  un tipo di carattere
�  un documento che contiene informazioni riguardanti la formattazione
�  una dimensione di pagina

Un foglio elettronico e’
�  una stampante intelligente
�  un modello di Microsoft Word
�  il tipo di documenti realizzabili tramite Microsoft Excel
�  una tabella che contiene valori e formule

Le righe di EXCEL sono identificate tramite
�  numeri romani
�  cifre arabiche
�  lettere

Le colonne di EXCEL sono identificate tramite
�  lettere
�  cifre
�  combinazioni alfanumeriche

Sia C11 un riferimento all’interno di una formula EXCEL. Esso e’ di tipo
�  relativo
�  assoluto
�  misto
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Sia $C$11 un riferimento all’interno di una formula EXCEL. Esso e’ di tipo
�  relativo
�  assoluto
�  misto

Sia $C11 un riferimento all’interno di una formula EXCEL. Esso e’ di tipo
�  relativo
�  assoluto
�  misto

In Windows, una presentazione PowerPoint e’ usualmente memorizzata in un file con estensione
�  pwr
�  ppt
�  pow

RTF e’
�  l’estensione di un file contenente testo formattato
�  un acronimo per Random Text File
�  un acronimo per Rich Text Format

Supponiamo di eseguire le seguenti operazioni in un documento WORD con 3 paragrafi: si seleziona il 
primo paragrafo, si esegue l’operazione CUT, si seleziona il secondo paragrafo, si esegue l’operazione 
COPY, si seleziona il terzo paragrafo e si esegue l’operazione PASTE. Il risultato finale sara’ un documento 
con

�  due copie del secondo paragrafo
�  il secondo paragrafo, poi il terzo, e di nuovo il secondo
�  il secondo paragrafo, poi il terzo, poi il primo e di nuovo il secondo
�  i paragrafi tutti mescolati

Supponiamo di eseguire le seguenti operazioni in un documento WORD con 3 paragrafi: si seleziona il 
primo paragrafo, si esegue l’operazione COPY, si seleziona il secondo paragrafo, si esegue l’operazione 
COPY, si seleziona il terzo paragrafo e si esegue l’operazione PASTE. Il risultato finale sara’ un documento 

�  uguale al documento iniziale con in fondo ripetuto sia il primo che il secondo paragrafo
�  uguale al documento iniziale con in fondo ripetuto il secondo paragrafo
�  con il primo paragrafo seguito da due copie del secondo

Cosa significa "rendere" (o "fare il rendering") una pagina Web?
�  scaricarla tramite protocollo http
�  visualizzarla tramite un browser
�  descriverla in HTML

Per visualizzare pagine Web si utilizzano programmi applicativi detti Browser. Fra questi programmi 
abbiamo:

�  Windows NT
�  NCSA Mosaic
�  Internet Explorer
�  Netscape Communicator

La formattazione di una parola in grassetto rappresenta un markup di tipo
�  tipografico
�  referenziale
�  presentazionale
�  descrittivo

ARIAL e’ un carattere 
�  serif
�  sans serif
�  mono

TIMES NEW ROMAN e’ un carattere 
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�  serif
�  sans serif
�  mono

COURIER e’ un carattere 
�  proporzionale
�  monodimensionale

A cosa serve il pulsante "get" della finestra di gestione del sito di Dreamweaver?
�  a trasferire file dal sistema locale a quello remoto
�  a trasferire file dal sistema remoto a quello locale
�  a prelevare da WWW una immagine

Cosa si intende con il termine scripting?
�  un tipo di carattere molto piccolo che puo’ essere visualizzato entro un documento HTML
�  una tecnica e gli strumenti per la creazione di pagine Web dinamiche
�  lo scrivere una pagina web in formato solo testo

Un documento HTML puo’ essere creato:
�  solo e unicamente con un programma editor HTML come, ad esempio, Dreamweaver 2
�  con un semplice editor di testo (ASCII)
�  necessariamente con un programma applicativo che permetta di spostare gli oggetti tramite il mouse.

Quali tra i seguenti programmi applicativi permettono di creare un qualsiasi documento HTML?
�  Notepad
�  Microsoft Outlook (mailer)
�  Wordpad
�  Telnet
�  Dreamweaver 2
�  FTP
�  Microsoft Word

Devo creare un documento HTML con Microsoft Word, scrivendo direttamente il codice HTML sorgente della 
pagina. Quali aspetti del file creato sono importanti e hanno effetto sulla pagina generata?

�  la dimensione e il colore del carattere usato nel documento Word
�  la dimensione della finestra di lavoro entro la quale si scrive il testo HTML
�  Solo il testo ASCII e le interruzioni di linea
�  i bordi, i margini, e il tipo (stile) di carattere usato

A cosa serve Microsoft Word?
�  è un programma di videoscrittura
�  è un sistema operativo
�  è un programma per gestire e stampare tabelle e grafici
�  è un programma per gestire la posta elettronica

A cosa serve Microsoft Excel?
�  è un programma utile per gestire tabelle e dati numerici correlati
�  è un programma per disegnare e ritoccare foto o immagini
�  è un programma per navigare su Web
�  è un programma che permette di creare grafici relativi a un sottoinsieme dei dati gestiti
�  è un programma a corredo di Microsoft Word

Che cosa rappresenta un foglio di lavoro in Microsoft Excel?
�  una tabella che puo’ contenere insiemi di dati interrogabili secondo varie modalita’ 
�  un insieme di caselle identificate da indici di riga e colonna, che possono contenere dati solo di tipo 

numerico
�  un insieme di caselle identificate da indici di riga e colonna, che possono contenere dati di qualsiasi tipo
�  una cartella del file system contenente il programma eseguibile Excel
�  un’area di lavoro che può contenere dati correlati e non, di qualsiasi tipo

Come si identifica una cella in un foglio Microsoft Excel?
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�  assegnando un nome mnemonico alle celle usate
�  attraverso la URL del file, seguita dal carattere # e poi dal nome mnemonico della cella
�  attraverso due coordinate che rappresentano gli indici di riga e colonna della cella

Cosa si intende con "formula" quando ci si riferisce al contenuto di una cella di un foglio Microsoft Excel?
�  una qualsiasi sequenza di caratteri
�  una qualsiasi sequenza di simboli purchè contenente il simbolo ’=’ all’interno
�  la definizione di una quantità variabile, derivata dal valore di celle diverse, attraverso la definizione di una

funzione matematica

Come si specifica una formula in una cella di un foglio di calcolo Excel?
�  si scrive l’elenco delle celle correlate selezionando il comando Edit > Copy
�  si inizia a scrivere la formula dopo avere inserito il cursore lampeggiante nella cella, iniziando con il 

carattere ’=’
�  si scrive la formula, dopo avere selezionato la cella, nell’apposito campo di immissione formula

Se modifico un dato numerico in una cella di un foglio di lavoro Excel:
�  il nuovo dato non viene mai preso in considerazione finché non salvo il foglio di lavoro
�  non è permesso modificare i dati se questi sono già stati salvati
�  il valore appena immesso viene immediatamente gestito, aggiornando tutte le celle che hanno valori 

dipendenti dal valore della cella modificata
�  il dato appena modificato può causare la modifica del valore di altre celle

Come si specifica il nome di celle in Microsoft Excel?
�  nome del foglio di calcolo, nome della riga e nome della colonna: es. fdc1A
�  nome della riga (numeri) seguito da nome della colonna (lettera): es., 1A
�  nome della colonna seguito da nome della riga: es., A1

Come si rappresenta il valore di una cella pari al prodotto delle due celle A3 e C4?
�  scrivendo il testo "A3*C4" all’interno della cella
�  scrivendo il testo "A3*C4" all’interno del campo formula dopo avere selezionato la cella
�  scrivendo il testo "A3,C4" all’interno della cella
�  scrivendo il testo "=A3*C4" all’interno della cella
�  scrivendo il testo "A3xC4" all’interno della cella

Cosa rappresenta il simbolo $ posto immediatamente prima dell’identificatore di riga o di colonna di una 
formula in una cella in un foglio di lavoro Excel?

�  che il dato contenuto nella cella è una quantità valutaria espressa in dollari
�  che il riferimento alla cella è da intendersi assoluto (quindi non modificabile in base allo spostamento)

qualora la formula sia copiata in un’altra cella
�  che il riferimento alla cella è da intendersi relativo (quindi modificabile in base allo spostamento) qualora

la formula sia copiata in un’altra cella

Come risulta la formula "=$A3+C$4" se viene copiata dalla cella A2 alla cella D5 in un foglio di lavoro 
Microsoft Excel?

�  "=$A6+C$7"
�  "=$D3+F$4"
�  "=$A6+F$4"
�  "=$A3+C$4"

Come risulta la formula "=$A$3+C4" se viene copiata dalla cella A2 alla cella D5 in un foglio di lavoro 
Microsoft Excel?

�  "=$A$6+C7"
�  "=$A$3+F7"
�  "=$D$3+F4"
�  "=$A$3+C4"

Come risulta la formula "=A3+C4" se viene copiata dalla cella A2 alla cella D5 in un foglio di lavoro Microsoft 
Excel?

�  "=A6+C7"
�  "=D3+F4"
�  "=A3+C4"
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�  "=D6+F7"

Cosa si intende con il termine "foglio elettronico"?
�  uno speciale dispositivo portatile utile per scrivere appunti e memorizzare gli appuntamenti
�  una tabella di valori messi eventualmente in relazione funzionale tra di loro, il cui aggiornamento e la cui 

consistenza vengonono mantenuti automaticamente da un programma applicativo
�  un oggetto ottenibile mediante Microsoft Word
�  un oggetto ottenibile mediante Microsoft Excel
�  un documento immagazzinato in un computer

In quali modi posso aumentare la dimensione del carattere usato in un documento visualizzato con Microsoft 
Word?

�  riscrivendo il testo e premendo i tasti più forte
�  riscrivendo il testo dopo avere aumentato la dimensione del carattere immettendo il valore opportuno nel 

campo dimensione carattere
�  senza riscrivere il testo, selezionando il testo e immettendo il valore opportuno nel campo dimensione 

carattere
�  utilizzando la funzione "zoom" dell’anteprima di stampa

Un file Word (.doc) salvato su disco occupa circa 2MB. Se diminuisco la dimensione dei caratteri usati del 
50% e salvo di nuovo il file, quanto sarà lo spazio occupato su disco?

�  dipende dalla fonte principale usate per il documento
�  circa invariata
�  circa il 50% in più
�  circa il 50% in meno

Quali dei seguenti sono i formati nei quali è possibile salvare (esportare) un documento di testo scritto con
Microsoft Word?

�  formato .xls
�  formato .doc
�  formato .exe
�  formato .txt
�  formato .rtf
�  formato .bin

Come posso salvare una copia con un nuovo nome di un documento aperto con Microsoft Word?
�  attraverso il comando Edit > Copia (Edit > Copy)
�  attraverso il comando File > Salva con nome (File > Save As)
�  attraverso il comando File > Salva Frameset con nome (File > Save Frameset As)

Un file .pdf può essere aperto (letto o modificato) con Microsoft Word?
�  no
�  si’, sempre
�  si’, ma solo col plug-in adatto
�  no, pero’ e’ facile trasformarlo in .rtf

Quali dei seguenti attributi possono essere specificati per un testo scritto con Microsoft Word?
�  i margini e i rientri del documento rispetto al foglio
�  la scrittura speculare, da destra a sinistra
�  la dimensione di una tabella o di un grafico
�  la dimensione massima occupabile su disco

Come si possono importare grafici realizzati con Microsoft Excel all’interno di documenti Word?
�  Importando il file (foglio di lavoro) contenente il grafico Excel attraverso il comando Inserisci > Oggetto
�  Non si possono importare: devono essere creati da Microsoft Word
�  Devono prima essere convertiti in formato solo testo per essere importati
�  Collegando il file (foglio di lavoro) Excel contenente il grafico all’interno del documento Word

Che differenza esiste tra un grafico Excel inserito in un documento Word mediante la modalita’ 
"Importazione" rispetto alla modalita’ "Collegamento"?

�  un grafico Importato in Word risulta soggetto automaticamente agli aggiornamenti dei dati che dovessero 
essere effettuati sul foglio di lavoro Excel
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�  un grafico Collegato in Word risulta soggetto automaticamente agli aggiornamenti dei dati che dovessero 
essere effettuati sul foglio di lavoro Excel

�  nessuna differenza
�  un grafico Importato in Word non risulta soggetto agli aggiornamenti dei dati che dovessero essere 

effettuati sul foglio di lavoro Excel

Quali finestre di Dreamweaver permettono di definire tutti (o quasi) i possibili attributi di un oggetto 
selezionato?

�  la pulsantiera (Launcher)
�  la finestra Oggetti (Objects)
�  la finestra Proprietà (Properties)
�  la finestra Sorgente HTML (HTML Source)

Come è possibile visualizzare in anteprima il risultato ottenuto dal caricamento del documento creato con
Dreamweaver?

�  devo necessariamente salvare il documento, pubblicarlo sul web server e accedervi con un browser
�  posso usare l’opzione File > Mostra anteprima con Browser, selezionando il browser che si intende usare
�  tutte le funzionalità del browser sono già implementate da Dreamweaver: l’anteprima è solo una verifica

della compatibilità del documento creato

E’ possibile inserire tabelle create con Microsoft Excel all’interno di un documento HTML mantenendone la 
formattazione e le dipendenze funzionali tra i valori?

�  No, non è possibile in alcun modo importare tabelle Excel
�  Si, è possibile inserire le tabelle, purché salvate in formato HTML da Microsoft Excel, mantenendo

formattazione e dipendenze funzionali
�  Si, è possibile inserire le tabelle, purché salvate in formato HTML da Microsoft Excel, mantenendo solo

la formattazione, ma non le dipendenze funzionali
�  Si, è possibile inserire le tabelle, purché salvate in formato HTML da Microsoft Excel, mantenendo solo

le dipendenze funzionali

La sigla ANSI sta per:
�  American Non Standard Interface
�  Associazione Nazionale Sistemi Informatici
�  American National Standards Institute

Con un Browser:
�  si scrivono documenti
�  si scrivono programmi in linguaggi ad alto livello
�  si naviga in Internet

Esistono tecniche di crittografia a:
�  chiave personale
�  chiave pubblica
�  chiave segreta
�  chiave privata
�  chiave accoppiata

Il Logaritmo e’:
�  un’analisi grafica delle funzioni vitali di una persona
�  una funzione matematica
�  un programma per risolvere un problema
�  un metodo risolutivo per un problema computazionale

Quando compiliamo un programma:
�  memorizziamo il programma dopo averlo completato con i dati di ingresso
�  eseguiamo il programma usando l’unita’ centrale
�  generiamo una traduzione del programma in un altro linguaggio di piu’ basso livello

Un documento con estensione .AVI contiene:
�  un brano musicale
�  un filmato
�  un testo
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�  un’immagine

Un documento con estensione .JPEG o .JPG contiene:
�  un brano musicale
�  un filmato
�  un testo
�  un’immagine

Un file con estensione .PDF contiene:
�  un brano musicale
�  un filmato
�  un documento creato da ACROBAT WRITER
�  un’immagine

Un programma scritto in Java:
�  puo’ essere eseguito solo sulla macchina su cui e’ stato compilato
�  puo’ essere eseguito solo su macchine virtuali Java
�  puo’ essere eseguito solo su macchine che montano un interprete Java
�  puo’ essere eseguito su qualsiasi macchina

I dati elaborati da un computer possono comprendere
�  Nessuna delle voci citate nelle altre risposte
�  Numeri di voli aerei
�  Prezzi di prodotti commerciali
�  Filmati video e suoni

Sequenze strutturate di istruzioni che definiscono inequivocabilmente l’esecuzione di un determinato 
compito da parte di un computer prendono il nome di

�  Programma
�  Sistema operativo
�  Hardware
�  Software

Microsoft Word e Netscape Navigator sono due esempi di
�  Programmi applicativi
�  Programmi per la navigazione di Internet
�  Programmi per videoscrittura

I fogli elettronici sono programmi pensati per
�  Navigare Internet
�  Eseguire disegni in grafica tridimensionale
�  Manipolare ed analizzare informazioni numeriche

Rappresentazioni grafico/tabellari di dati numerici, foto, caratteri animati e oggetti in movimento, suoni e 
filmati sono esempi di dati che

�  Possono essere trattati dai moderni elaboratori
�  Possono essere trattati solo da elaboratori molto costosi
�  Non possono essere trattati dagli odierni elaboratori

Un software donato gratuitamente al pubblico rinunciando ad OGNI diritto su di esso e’ detto
�  Shareware
�  Di pubblico dominio
�  Freeware

Quali tra i seguenti suffissi denotano documenti che contengono musica?
�  .zip
�  .mp3
�  .gif
�  .doc

Quali dei seguenti programmi vengono detti browser?
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�  Microsoft Office
�  Microsoft Internet Explorer
�  Netscape Navigator
�  Adobe Acroreader

Cos’e’ un attachment?
�  Un programma cliente connesso ("attached") ad un server
�  Un file allegato ad un messaggio di posta elettronica
�  Un programma "intelligente" in grado di identificare un mittente di messaggi di email anche se usa uno 

pseudonimo

Cos’e’ un plug-in?
�  Un particolare dispositivo di input che si "infila" (plug) in una delle porte del computer
�  Un componente software del browser, ma da esso distinto, necessario per visualizzare certi tipi di 

documenti
�  Una delle porte presenti sul retro di un personal computer
�  Un programma capace di accendere o spegnere un computer

Quali tra i seguenti sono linguaggi di mark-up?
�  HTML
�  Unicode
�  PostScript
�  ASCII

Cosa vuol dire l’acronimo WYSIWYG?
�  What? You Said I Waste Your Gigabytes?
�  Descrive le lettere della prima riga di una tastiera americana
�  What You See Is What You Get
�  What You Send Is What You Give

Quali tra i seguenti sono formati di documenti comunemente usati su Internet?
�  HTML
�  PDF
�  FTP
�  ISDN

Per quali tipi di documenti e’ necessario il plug-in QuickTime?
�  Video digitali e simulazioni 3D
�  VRML
�  Audio MP3

Per quali tipi di documenti e’ necessario il plug-in Flash?
�  VRML
�  Audio MP3
�  Per stream audio/video realizzati, ad esempio, con Macromedia Director

Per quali tipi di documenti e’ necessario il plug-in Adobe Acrobat Reader?
�  Per documenti PostScript
�  Per documenti video digitali e simulazioni 3D
�  Per documenti in Portable Document Format

Per quali tipi di documenti e’ necessario il plug-in Cosmo Player?
�  VRML
�  Video digitali
�  Audio compressi

Quale di questi documenti richiede piu’ tempo per essere trasmesso in forma digitale SENZA 
compressione?

�  Una pagina HTML con animazioni
�  Un’immagine GIF della Gioconda di Leonardo
�  Il contenuto di un’enciclopedia in 20 volumi
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�  Un film di due ore ad alta risoluzione con audio HIFI
�  La Nona Sinfonia di Beethoven

L’immagine utilizzata per rappresentare le icone dei file in Explorer dipende da:
�  la cartella nella quale il file e’ memorizzato
�  l’estensione del file
�  il contenuto del documento memorizzato nel file

Al momento quali tra i seguenti vi sembrano problemi importanti da un punto di vista sociale nell’uso 
corrente di Internet?

�  Protezione dell’hardware dei server dal furto
�  Protezione dei minori dalla pornografia
�  Protezione della proprieta’ intellettuale
�  Protezione delle password dei siti protetti
�  Protezione della privacy personale

Che cos’e’ un’"opzione di default" proposta da un programma?
�  Una scelta opzionale
�  Una scelta predeterminata ma modificabile
�  Una scelta sbagliata
�  Una scelta obbligata

Cos’e’ un documento multimediale?
�  Un documento che include un commento musicale
�  Un documento che include testo, grafica, audio, video
�  Un documento scritto con HTML

Cos’e’ un emulatore?
�  Un programma che emula, cioe’ simula, un videogioco
�  Un programma che emula, cioe’ simula, il linguaggio machina di un processore
�  Un programma che emula, cioe’ simula, un sistema operativo

Cos’e’ un programma di emulazione di terminale?
�  Un programma che consente di simulare un dispositivo di terminazione
�  Un programma che consente di ricevere fax via modem
�  Un programma che consente di usare un modem
�  Un programma che trasforma il computer locale in terminale di input (emula la tastiera) e output (emula lo 

schermo) di un computer remoto
�  Un programma che consente di contattare un Internet provider

Quale tipo di dati consuma piu’ banda di comunicazione quando viene trasmesso?
�  Testo ASCII
�  Audio di qualita’ telefonica
�  Audio stereo
�  Videoconferenza

Cos’e’ un "signature file"?
�  Un meccanismo di protezione crittografica dei messaggi di email
�  E’ un file attaccato automaticamente in coda ai messaggi in uscita; di solito contiene dati personali del 

mittente
�  Una firma digitale che autentica i messaggi di email

Copiare musica su Internet da un CD musicale originale che si e’ comprato in negozio
�  E’ ammesso se si ha il permesso del negozio
�  E’ ammesso se si riportano i dati del CD (numero di matricola)
�  E’ sempre ammesso
�  E’ un reato

Che cos’e’ la Patente Europea dei computer?
�  Un test simile a questo
�  Il permesso di creare siti WWW in Europa
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�  Un certificato di alfabetizzazione informatica con validita’ europea
�  Una licenza che permette di navigare su siti della Comunita’ Europea

Che cos’e’ il copyright?
�  Un insieme di priviliegi normalmente di pertinenza del proprietario di un documento
�  Un insieme di priviliegi normalmente di pertinenza dell’autore di un documento
�  Il diritto di copiare un documento

Quali sono le principali differenze tra formato PostScript e formato PDF?
�  I documenti PostScript possono essere ipertestuali, quelli PDF no
�  I documenti PDF ottimizzati occupano di solito meno spazio di corrispondenti documenti PostScript
�  PostScript e’ adatto per stampanti, PDF e’ indipendente dal dispositivo
�  PostScript e’ un linguaggio human-readable, PDF e’ machine-readable
�  PostScript e’ un linguaggio di Apple, PDF e’ di Adobe

Quali dei seguenti suffissi denotano documenti grafici?
�  HTM
�  EPS
�  PDF
�  TAR
�  PNG
�  JPG
�  WAV
�  GIF

Cos’e’ un banner?
�  Un tipo di documento
�  Un sito dedicato al commercio elettronico
�  Un elemento grafico di una pagina HTML, di solito con pubblicita’

Quale tra i seguenti tipi di documenti occupa presumibilmente piu’ spazio?
�  Il testo della Divina Commedia
�  Una foto a tuto schermo di Nicole Kidman in formato GIF
�  Un videoclip di un minuto

Quale tra i seguenti termini puo’ usarsi come sinonimo di "browser"?
�  Compilatore
�  Traduttore
�  Editor
�  Visualizzatore

Ho un computer e sistema operativo molto moderno. Vorrei usarlo per poter giocare con un vecchio 
videogioco che funzionava su Commodore 64, uno home computer degli anni ’80. Il programma lo trovo in 
rete. Cos’altro mi occorre?

�  Ho bisogno dell’unita’ dischi del Commodore 64
�  Ho bisogno di un emulatore del Commodore 64 per l’architettura hw/sw che possiedo
�  Ho bisogno del sistema operativo del Commodore 64
�  Ho bisogno di un monitor che simuli la grafica del Commodore 64

Quali tra le seguenti applicazioni possono sostituire l’applicazione Dreamweaver come editor di pagine 
HTML?

�  Linux
�  Microsoft Frontpage
�  Netscape Composer
�  MacOS

Che cos’e’ il programma Microsoft Access?
�  Un sistema di gestione di database
�  Un cliente di posta elettronica
�  Un Web server
�  Un programma di impaginazione
�  Un programma di fotoritocco
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Cosa vuol dire che un’applicazione e’ distribuita col sistema dell’Open Source Software?
�  Viene distribuito sia il codice eseguibile che il codice sorgente, quindi e’ possibile modificare il programma

dell’applicazione
�  Viene reso noto chi e’ l’autore del programma, che di solito e’ segreto
�  Viene resa nota la software house che ha prodotto il programma, che ne e’ garante
�  Quell’applicazione viene distribuita "gratis"

Che cos’e’ un documento GIF animato?
�  Un GIF creato con ShockWave
�  Una sequenza di GIF standard "ricucita" in un unico documento con istruzioni atte a mostrare le singole 

immagini in sequenza temporale
�  Un GIF che si carica velocemente

Devo scrivere in fretta un elenco di 100 cognomi di studenti, che poi devo stampare in lista ordinata 
alfabeticamente. Quali tra le seguenti applicazioni risolvono facilmente questo problema?

�  Microsoft Explorer
�  Microsoft Outlook
�  Microsoft Paint
�  Microsoft Excel
�  Microsoft Word

Qualcuno mi ha mandato un documento PostScript, ma devo apporvi alcune correzioni. Come faccio?
�  Devo usare Adobe Distiller
�  Non si puo’ far nulla
�  Devo conoscere il linguaggio PostScript, e usare un editor testuale per modificare la rappresentazione 

ASCII del documento
�  Devo usare un editor capace di modificare documenti PostScript

Qualcuno mi ha mandato un documento PDF, ma devo apporvi alcune correzioni. Come faccio?
�  Devo usare Adobe Distiller
�  Non si puo’ far nulla
�  Devo conoscere il linguaggio PDF, e usare un editor testuale per modificare la rappresentazione ASCII 

del documento
�  Devo usare un editor capace di modificare documenti PDF

Come mai un minuto di musica in formato MIDI di solito occupa molto meno spazio che in uno dei formati 
tipici audio (es. RealAudio, MP3)?

�  Un file MIDI è compresso con algoritmi speciali
�  Un file MIDI è analogico
�  Un file MIDI non è una codifica audio: rappresenta invece direttamente le note musicali suonate da certi

strumenti

Quali tra le seguenti funzioni è ragionevole aspettarsi in un programma di editing di testi?
�  Protezione antivirus
�  Esecuzione di comandi HTML
�  Ricerca di una stringa con sostituzione
�  Taglia e incolla

Quali tra le seguenti funzioni è ragionevole aspettarsi in un programma di gestione di fogli elettronici?
�  Protezione antivirus
�  Esecuzione di comandi HTML
�  Ricerca di una stringa con sostituzione
�  Taglia e incolla

Supponendo di avere un file aperto in Microsoft Word, l’aumentare la dimensione della finestra, 
trascinandone il margine con il mouse, determina un aumento dell’area di memoria necessaria a 
memorizzare il documento aperto?

�  Si, sempre
�  Si, a volte
�  No, mai
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Applicando piu’ volte lo stesso algoritmo di compressione dei dati a un file da spedire in rete, si ottiene ogni 
volta una riduzione della dimensione del file, fino a un limite inferiore arbitrario?

�  Si, sempre
�  Si, ma non sempre
�  No. mai

Perche’ non si comprimono sistematicamente tutti i byte trasmessi in rete?
�  perche’ il vantaggio della compressione dei file diventa significativo solo quando i file da comprimere 

hanno una certa estensione
�  perche’ le reti sono ormai veloci al punto di rendere superflua la compressione dei dati trasmessi
�  perche’ e’ uno spreco di lavoro tentare di comprimere file di dimensione limitata
�  perche’ non esistono algoritmi di compressione a sufficienza

Quale metodo e’ migliore per rendere indecifrabile un testo da parte di eventuali spie?
�  usare una chiave di codifica basata su fattorizzazione di numeri primi
�  spedire un carattere al giorno in ore diverse scelte a caso
�  spedire per ogni carattere utile 10 caratteri di disturbo presi a caso

Dovendo memorizzare la combinazione di una 24 ore, Occupa piu’ memoria il valore 312 espresso in 
binario, o la sequenza di caratteri 3,1,2?

�  occupa piu’ memoria il valore in binario
�  occupa piu’ memoria la sequenza di caratteri
�  occupano entrambi la stessa memoria

Perche’ non e’ possibile comprimere un file, e poi ricomprimere il risultato all’infinito ottenendo un file piccolo 
a piacere?

�  perche’ dopo la seconda volta, non potrei piu’ ottenere il file non compresso
�  perche’ l’algoritmo di compressione applicato una volta rende il file compresso ottenuto ottimizzato, dal 

punto di vista della tecnica di compressione usata
�  perche’ dopo la seconda volta il file anziche comprimersi aumenta di dimensione

Quali di questi sono sistemi operativi?
�  Linus
�  Snoopy
�  Windows NT
�  Unix
�  Explorer
�  Stargate
�  Linux
�  MacOS

Quali delle seguenti funzioni sono supportate direttamente da un Browser?
�  risoluzione nomi DNS
�  modifica di pagine Web in rete
�  Gestione del file History
�  pubblicazione di siti WEB
�  condivisione di file
�  Navigazione in Internet

Il sistema satellitare denominato GPS e’ usato per
�  individuare posizioni sul globo terrestre
�  fare previsioni meteorologiche
�  guidare i satelliti nello spazio
�  telefonia satellitare
�  in un auto, per l’impianto di navigazione satellitare

Applicativi del tipo Computer aided design (CAD) sono utilizzati per
�  progettare sistemi
�  trasmettere file multimediali su Internet
�  connettersi a Internet
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Applicativi del tipo Computer Aided Manufacturing sono utilizzati per
�  inviare messaggi di posta elettronica
�  telefonare su Internet
�  produrre automaticamente sistemi o singole parti di un sistema

Il PDF (portable document format) e’ un formato per documenti prodotto da un programma applicativo 
denominato 

�  Acrobat
�  Word
�  Excel

La piu’ piccola unita’ di dato in un database e’
�  un campo
�  un record
�  una tabella

I fogli elettronici sono strutturati in righe e colonne, all’intersezione di ogni colonna e riga si puo’ immettere il
dato in una cosi’ detta

�  casella
�  cella
�  tabella

Di quale applicativo e’ tipico il suffisso .pps?
�  PostScript
�  Printable PostScript
�  PowerPoint
�  Office
�  Word
�  Wordpad

Cosa significa OPAC?
�  Organization of Petroleum Advanced Countries (acronimo dell’organizzazione degli stati che producono 

petrolio)
�  Optimizing Perfect Abstract Compiler (tipo di traduttore di linguaggi di programmazione)
�  OPen ACcess (tipo di livello di sicurezza di un sito Web)
�  On Line Public Access Catalogue (catalogo pubblico, on line, di una biblioteca)

Qual e’ il formato tipico dei filmati video digitali che vanno su DVD?
�  MP3
�  Mpeg2
�  GIF
�  JPEG
�  Quicktime

Quali tra le seguenti sono applicazioni tipiche di un programma come Microsft Word?
�  Creare presentazioni animate e multimediali
�  Creare tabelle e grafici a partire da insiemi di dati
�  Impaginare un documento complesso
�  Creare un sito Web
�  Creare un documento testuale

Cos’e’ un’applicazione "drag and drop"?
�  Un’applicazione gratuita
�  Un’applicazione meno versatile di quelle "plug and play"
�  Un’applicazione di sistema operativo
�  Un’applicazione che si apre trascinando l’icona di un documento sulla sua icona
�  Un’applicazione gratuita per un periodo limitato

Le operazioni "cut and paste" coinvolgono:
�  Lo schermo



Lista Domande http://phd.cs.unibo.it/esweb/lista_domande2.php

16 of 17 11/12/03 17:34

�  La clipboard
�  Il sistema operativo
�  La tastiera
�  Dispositivi speciali per sagomare i tabulati di output

La societa’ piu’ potente e famosa nel campo del software si chiama
�  Microsoft
�  INTEL
�  IBM
�  Sun Microsystems
�  Oracle
�  SAP

Un mio amico si appresta a presentare la sua dissertazione di laurea. Vuole usare qualche software per 
preparare la presentazione. Gli consiglio:

�  Excel
�  Word
�  Powerpoint
�  Frontpage
�  Windows
�  Access
�  Internet Explorer
�  Outlook

Che cos’e’ un e-book?
�  Un libro scritto in HTML
�  Un libro venduto solo su Internet
�  Un particolare formato di documento elettronico, adatto per libri
�  Il formato cartaceo tipico delle stampanti in Europa (opposto di us-book)

Ho scritto un documento e devo contare quanti caratteri contiene. Questa funzione:
�  e’ tipica del sistema operativo
�  e’ tipica dei programmi di videoscrittura
�  e’ tipica di un foglio elettronico
�  occorre usare un programma di analisi lessicale

Qual e’ l’intruso?
�  Frontpage
�  Netscape composer
�  Dreamweaver
�  Outlook

Quale formato grafico e’ piu’ adatto per comprimere fotografie?
�  ZIP
�  Quicktime
�  PDF
�  JPEG
�  GIF

Quali di questi formati di documento sono compressi "lossy" (con perdita di informazione)?
�  JPEG
�  MP3
�  PostScript
�  PDF
�  MIDI

Il formato PDF:
�  E’ binario e proprietario
�  E’ testuale e proprietario
�  E’ binario e di pubblico dominio
�  E’ testuale e di pubblico dominio
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Un’animazione FLASH
�  si basa su grafica vettoriale
�  si basa su grafica bitmap
�  si basa su GIF animate
�  si basa su streaming video

Quali tra questi formati di documento sono visualizzati direttamente dal programma Microsoft Word?
�  pdf
�  doc
�  html
�  txt
�  postscript

Cos’e’ un Digital Rights Management System?
�  Un sistema di controllo della privacy della posta elettronica
�  Unsistema di controllo e pagamento dei diritti d’autore sui documenti digitali
�  Un movimento d’opinione di difesa dei diritti individuali su Internet

Cos’e’ un font?
�  Un insieme di forme di caratteri tipografici, come per esempio Times o Verdana
�  Un codice di rappresentazione alfanumerica, come per esempio ASCII o Unicode
�  Un sito Web specializzato in news (una font giornalistica)
�  Un documento di alta qualita’ tipografica

Come si fa a creare un documento PDF?
�  L’applicazione Acrobat puo’ creare documenti PDF
�  L’applicazione Acrobat Reader puo’ creare documenti PDF
�  Alcune applicazioni riscono a salvare in formato PostScript se dispongono del plug-in relativo
�  Non e’ mai possibile salvare un documento in formato PDF

Per stampare documenti scaricati dal Web, occorre
�  Uan stampante normale
�  Una stampante Postscript
�  Un mouse pad compatibile con Explorer o Netscape
�  Una stampante a colori
�  Una stampante collegata in Internet

E’ possibile inserire un file pdf in un documento Word?
�  si’, sempre
�  si’, nelle versioni di Word più recenti
�  si’, nelle versioni PDF più recenti
�  si’, ma solo se non contiene figure
�  si’, nelle versioni di Windows più recenti

Qual e’ l’intruso?
�  .pdf
�  .ps
�  .txt
�  .mov
�  .doc


